Chapter No. 2
"The Edge Application Interface"
In this package, you will find:
A Biography of the author of the book
A preview chapter from the book, Chapter NO.2 "The Edge Application Interface"
A synopsis of the book’s content
Information on where to buy this book

About the Author

**Joseph Labrecque** is primarily employed by the University of Denver as Senior Interactive Software Engineer specializing in the Adobe Flash Platform, where he produces innovative academic toolsets for both traditional desktop environments and emerging mobile spaces. Alongside this principal role, he often serves as adjunct faculty, communicating upon a variety of Flash Platform solutions and general web design and development subjects.

In addition to his accomplishments in higher education, Joseph is the Proprietor of Fractured Vision Media, LLC a digital media production company, technical consultancy, and distribution vehicle for his creative works. He is founder and sole abiding member of the dark ambient recording project "An Early Morning Letter, Displaced" whose releases have received international award nominations and underground acclaim.


For More Information:  
He regularly speaks at user-group meetings and industry conferences such as Adobe MAX, FITC, D2W, 360|Flex, and a variety of other educational and technical conferences. In 2010, he received an Adobe Impact award in recognition of his outstanding contribution to the education community. He has served as an Adobe Education Leader since 2008 and is also an Adobe Community Professional.


Thanks to my family, friends, and benefactors for your continued support.
Adobe Edge
Quickstart Guide

Edge is an all-new tool from Adobe (currently in pre-release) that seeks to enable the authoring of motion and interactive experiences through HTML, CSS, and JavaScript in a manner consistent with other Creative Suite applications. The Edge application shares many features with other Adobe products, particularly Flash Professional, After Effects, and InDesign. This book will detail how to use this professional authoring software to create highly engaging content that targets Web standards. Content created in Adobe Edge does not rely on a plugin, so it can be run within any standard browser, even on mobile devices. The goal of this quickstart guide is to provide a direct overview of what it takes to create engaging content for the Web and provide a level of familiarity with Edge in order to actually get it done!

What This Book Covers

Chapter 1, Introduction to Adobe Edge, provides a look at the shifting Web landscape and how changes within devices and browser capabilities have made it possible for Adobe Edge to come about as a useful tool in the field of web design and development.

Chapter 2, The Edge Application Interface, provides a comprehensive overview of the entire Edge application interface. This overview includes a look at the panels, tools, menus, and other application elements that we will need to familiarize ourselves with when using Edge.

Chapter 3, Working with Edge Tools and Managing Assets, delves into many of the tools contained within the Edge application to allow the creation of rectangular elements, text, and assorted other objects.

Chapter 4, Creating Motion with Edge, demonstrates how simple it is to build a composition that involves a number of animated elements and presents a unique toolset for dealing with motion on the Web.

Chapter 5, Adding Interactivity to an Edge Composition, will expand upon the motion-based topics of Chapter 4 through the addition of interactive elements within an Edge project.

Chapter 6, Additional Resources, provides additional resources, which are available over the Internet and also seeks to add a few tips and tricks not covered in the preceding chapters. We close out with a preview of the forthcoming comprehensive book Learning Adobe Edge, Packt Publishing.

For More Information:
Adobe Edge boasts a modern, designer-friendly user interface that should be somewhat familiar to longtime users of the Adobe Creative Suite applications. This chapter will run through each aspect of the interface, including:

- Interface features
- Application menus
- The Toolbar
- The Stage
- The Timeline
- Edge panels

After processing the information presented, we should have a clear understanding of the interface as a whole and also the usefulness of individual aspects.

**Application interface overview**

Being primarily focused on motion and interactivity, the Edge interface places a great emphasis upon modifying element properties over time. We will discover that Edge places many useful sections of the interface such as the *Stage*, *Timeline*, and *Properties* panels in plain view in order to make these tools readily available in our work.

For More Information:  
The application window

Whether running Edge on Windows or OS X, the application window will appear very similar across platforms. In many of Adobe's creative products, the windowing on OS X is very different than it is on Windows. With Edge, the operating mode is the same across platforms; so while the reader will notice most of the screenshots in this book featuring from the Windows version of Edge, there should be very little difference when running the application on OS X.

The application window itself is broken into a variety of separate modules. Most of these modules fall under the category of "panels" and can be toggled on and off, collapsed, combined with other panels, or anchored to different areas of the application window. Most of these actions are done through mouse actions and dragging.

Customizing the Edge panel layout

Any panel in Edge can be anchored to the application window or can be made to float within a small utility window. Floating panels are useful if placing them across different monitors on a full workstation, whereas docking these panels can preserve space on a smaller laptop display.
To tear a panel out of the main application window and create a floating panel, simply click upon the grippies (the textured area of the panel tab) next to an anchored panel's name. While the mouse button remains pressed, pull the panel from its present location. We will see the panel has now changed state.

At this point, as we move our cursor among other interface elements, we will see a grid appear from time to time with portions of the grid highlighted in a violet color. This color indicates that the panel may be dropped in this location to be anchored in that particular position. Release the mouse button to dock the panel, or release it when there is no highlighted portion of the grid to allow the panel to remain in a floating state.

[ ] Dragging a panel totally off of the application window and releasing it will ensure that we create a floating panel.

**Managing workspaces**

In a similar fashion to other Creative Suite applications, Edge provides the ability to customize the workspace and preserve a variety of these customizations through the concept of application workspaces.
The Edge Application Interface

The ability to easily switch between different workspaces is useful when moving between the layout, animation, and interactivity portions of a project, as the relevant panels and other interface structures can be given more prominence, and those which are not needed for certain tasks can be either dismissed or placed in a smaller role.

To create a new workspace, we will perform the following actions:

1. First, locate the **Workspace** drop-down in the upper-right portion of the Edge application window. Click on it to reveal the drop-down choices.

   ![Workspace Drop-Down](image)

2. Select **New Workspace** and provide a Name for your custom workspace. Select **OK** once you are finished.

   ![New Workspace Dialog](image)

3. To verify that your workspace has been saved, return to the **Workspace** drop-down and click on it once again. Your new workspace will appear in the list of choices. Switching between workspaces is now as simple as performing a quick selection using this drop-down control.
We have a few other options for managing our workspaces apart from **New Workspace**. We also have **Delete Workspace**, which deletes the currently selected workspace from memory. Also useful is the ability to reset a workspace that has been modified by choosing the **Reset "[workspace]"...** option. In case, while working, we have modified our workspace to assist with a particular task the reset option allows us to quickly revert to our saved workspace instead of manually moving things back to how they were.

### The Edge menu system

Most computer programs have a standard menu system that includes choices such as **File**, **Edit**, and **View**, along with a variety of application-specific choices. Edge is no different in this regard.

We will have a look at the options available to us from the Edge application menu and provide a brief overview of the function of each option.

---

For More Information:
The Edge Application Interface

File
The File menu option provides a number of options for working with Edge files themselves.

- **New**: Creates a new, blank Edge project.
- **Open**: Opens a previously saved Edge project.
- **Open Recent**: Provides a list of recently opened Edge projects that a user can select from. Selecting one of these projects will load it into Edge, similar to the Open command.
- **Close**: This command will close the current Edge project, prompting the user to save the document first, through an application alert window.
- **Close All**: Closes all Edge projects that are currently open. Similar to the Close command, a dialog box requesting the user to save each project will appear in a sequence.
- **Save**: Saves the current Edge project. Only valid for previously saved projects.
- **Save As...**: Opens a browse dialog prompting the user to provide a project file name and location to save the Edge project. Previously unsaved projects are required to use this command.
- **Revert**: Reverts an opened and modified Edge project to its last saved state.
- **Preview In Browser**: While it is possible to preview certain things within the Edge application itself, as projects become more complex, we will want to be sure and run them within a true browser environment. This command will launch a browser and load in the current Edge project automatically.
- **Import...**: Allows the import of .png, .gif, .jpg, and .svg files into an Edge project. These imported files will appear in the project Library and upon the stage.
- **Exit**: Closes the entire application. If there are unsaved projects open, Edge will prompt the user to save the document first, through an application alert window.

For More Information:
Edit

The Edit menu allows for direct object manipulation through cut, copy, and paste commands, along with selection options, and access to an undo/redo history.

- **Undo:** Reverts the previous action. This command will change based upon context, letting the user know precisely which action will be affected.
- **Redo:** Reverts the previous **Undo** command. This command will change based upon context, letting the user know precisely which action will be affected.
- **Cut:** Removes the selected element. The user may decide to **Paste** this element elsewhere.
- **Copy:** Copies the selected element. The user may decide to **Paste** this element elsewhere.
- **Paste:** Pastes the previously cut or copied element onto the stage while preserving element properties such as position, opacity, rotation, and so forth.
- **Paste Special:** This is actually a series of commands which allows the pasting of specific attributes. Similar to any **Paste** command, these attributes or an accompanying element must have been cut or copied previous to this.
  - **Paste Transitions To Location:** Will replicate the exact motion from the copied element upon the selected element. The Transition will terminate upon the elements present position.
  - **Paste Transitions From Location:** Will replicate the exact motion from the copied element upon the selected element. The Transition will begin at the elements present position.
  - **Paste Inverted:** Will paste an inverted (or reverse) sequence of what has been copied or cut into the Timeline.
  - **Paste Actions:** Will paste only the Actions defined on the element that has been copied or cut to a new element.
  - **Paste All:** Will paste the element which has been copied or cut as a new element along with all properties, Actions, and Transitions into the Timeline.
- **Duplicate:** Makes a perfect copy of the selected element. All properties and attributes are preserved and the original object is left intact.
- **Select All:** Selects everything on the stage.
- **Delete:** Removes the selected element from the stage without preserving the object for a **Paste** command in the future.

For More Information:
The Edge Application Interface

View

Commands from the View menu determine how the stage appears within the application window.

- **Zoom In**: Zooms in the entire stage for fine adjustments when placing objects or modifying their properties. If the stage appears larger than its panel, scrollbars will be present.
- **Zoom Out**: Zooms the stage out further. Useful if working on smaller, cramped screens.
- **Actual Size**: Resets the stage to its actual size as given in the Properties panel.

Modify

The Modify menu includes commands that pertain to elements on the stage and how the stage interacts with these elements. Most of these commands pertain to layout and distribution options, but also particular commands, which deal with the management of Symbols.

- **Arrange**: The arrangement commands modify the z-index of visual elements on the stage.
  - **Bring to Front**: Switches the selected element z-index position to the very top of the viewing stack.
  - **Bring Forward**: Switches the selected element z-index position to the spot above its current position within the viewing stack.
  - **Send Backward**: Switches the selected element z-index position to the spot below its current position within the viewing stack.
  - **Send to Back**: Switches the selected element z-index position to the very bottom of the viewing stack.

- **Align**: This set of commands adjusts the x or y positions of selected elements with one another.
  - **Left**: Aligns selected elements to the left-most element.
  - **Horizontal Center**: Aligns selected elements to their horizontal center.
  - **Right**: Aligns selected elements to the right-most element.
  - **Top**: Aligns selected elements to the top-most element.
  - **Vertical Center**: Aligns selected elements to their vertical center.
  - **Bottom**: Aligns selected elements to the bottom-most element.

For More Information:
• **Distribute:** These commands adjust the x or y positions of selected elements to one another.
  - **Left:** Distributes selected items along the left edge.
  - **Horizontal Center:** Distributes selected items along the horizontal center.
  - **Right:** Distributes selected items along the right edge.
  - **Top:** Distributes selected items along top edge.
  - **Vertical Center:** Distributes selected items along vertical center.
  - **Bottom:** Distributes selected items along the bottom edge.

• **Enable Smart Guides:** Enables smart guides to appear when dragging elements around the stage. Smart guides assist in the alignment of items in relation to one another.

• **Convert to Symbol…:** Converts the selected elements on the stage into a new symbol, allowing us also to provide the symbol with a name through a simple dialog.

• **Edit Symbol:** If a symbol has been selected, Edge switches the view to an isolation mode within that symbol in order to edit its contents.

### Timeline

As Edge is a motion- and animation-focused tool, the following **Timeline** commands listed are core to achieving the most we can through the application interface.

• **Play/Pause:** Toggles playback of the timeline.
• **Move Playhead to Start:** Sends the timeline playhead to 0 milliseconds.
• **Move Playhead to End:** Sends the timeline playhead to the very end of the established timeline.

• **Auto-Keyframe Properties:** Setting this will enable Edge to generate keyframes for various properties automatically as they are adjusted along the timeline.

• **Generate Smooth Transitions:** Informs Edge to use smooth transitions between element property adjustments.

• **Insert Label:** Adds a label marker at the current playhead position. The label name can be edited.

• **Insert Trigger:** Adds a new trigger to the Actions layer along the timeline at the current playhead position.
The Edge Application Interface

- **Insert Time**: Invokes a dialog that allows the insertion of time extending from the current playhead position along the timeline. This will extend the overall timeline length as well.

- **Toggle Mark**: Toggles the mark on and off, depending upon particular preferences when animating elements.

- **Snapping**: Toggles snapping on and off.

- **Snap To**: Specifies the snapping settings when snapping has been toggled on.
  - **Quarter Seconds**: Snap to quarter seconds along the timeline
  - **Playhead**: Snap to the playhead position
  - **Transition Edges**: Snap to transition edges

- **Zoom In**: Scales the stage in from its current scale.

- **Zoom Out**: Scales the stage out from its current scale.

- **Zoom to Fit**: Scales the stage to fit within constraints imposed by the size of the application window.

- **Expand/Collapse Selected**: Expands selected elements within the timeline to expose their individual keyframes.

- **Expand/Collapse All**: Expands all elements within the timeline to expose their individual keyframes.

The following screenshot is an example of a Timeline menu:

For More Information:
Window

The Window menu provides the ability for an Edge user to toggle various application panels on and off. The following screenshot is of a Window menu:

Certain panels are off by default; turning them on will allow us to anchor them to the application window, or otherwise position them as floating panels. In this menu, we are also given access to workspace management commands.

- **Workspace**: Provides a number of commands for managing Edge workspaces.
  - **Default**: (also listed are any defined workspaces): These are simply quick access commands to switch between defined workspaces.
  - **New Workspace**: This command will save the current application window configuration as a named workspace for later recall.
  - **Delete Workspace**: Deletes the currently selected workspace from application memory.
  - **Reset 
    ![workspace](image)"...: This command allows us to quickly revert to our saved workspace to its saved state.

- **Timeline**: Toggles the Timeline within the Edge application window.
- **Elements**: Toggles the Elements panel within the Edge application window.

For More Information:
The Edge Application Interface

- **Editor**: Currently disabled in Edge Preview Release 4.
- **Library**: Toggles the Library panel within the Edge application window.
- **Tools**: Toggles the Tools panel within the Edge application window.
- **Properties**: Toggles the Properties panel within the Edge application window.
- **Code**: Currently disabled in Edge Preview Release 4.

Help

This menu item contains information about Edge as a product, and links to information about the APIs which exist when interacting with the runtime through JavaScript.

- **About Product Improvement Program...**: An opt-in to allow the user to participate in improving the product through the collection of anonymous usage statistics.
- **About Adobe Edge...**: Selecting this will bring up information about Edge, including specific version information.
- **About JavaScript API...**: Provides an overview of the Adobe Edge Runtime API (requires an Internet connection).

The Edge Toolbar

The Edge Toolbar, by default, is located along the top left of the application window and contains an assortment of tools used when interacting with the stage. In this toolbar, we will discover a selection tool, vector element creation tools, and a text tool for working within the Edge Stage.

Each Adobe Edge Preview has added a significant amount of new features to the application. We can expect that the Toolbar may also continue to improve with time.

For More Information:
Selection tool

The Selection tool appears as a little cursor arrow and is used to make selections upon the project stage. Any elements added to the stage can be selected using this tool and holding down the Shift key, a user can toggle the selection of multiple elements at once.

A user is also able to draw a selection box across elements by clicking upon an area of the stage that includes no other elements and dragging across multiple elements before releasing the mouse. This will draw a selection rectangle during the selection process, which will go away once a selection has been completed.

Once objects are selected, they can be modified in many different ways through the use of panels and menu systems within the Edge application window.

For More Information:
Transform tool
The Transform tool allows us to modify certain transform properties through direct manipulation of the object on the stage. There is a subtle difference, between the Transform and Selection tools, but it is a very important one. When using the Transform tool to modify an element, we are modifying transform properties in relation to the Transform Point, while the Selection tool can modify only properties such as width and height. The following is a screenshot of the Transform tool:

The Transform Point can be moved anywhere within the element or even outside of the element to create a number of interesting motion effects.

For More Information:
Rectangle tool

The Rectangle tool looks similar to a small rectangle in the Toolbar. Selecting this tool allows us to create rectangular elements directly upon the stage. To create a new rectangle using this tool, we click upon the stage and drag the mouse across the area we wish the rectangle to appear over, finally releasing the mouse once we are finished. Holding the Shift key down while dragging out our rectangle will allow us to create a perfect square.

After a rectangle has been created, we can manipulate the small black diamonds at each corner to form a rounded rectangle.

For More Information:
Rounded Rectangle tool

The Rounded Rectangle tool is almost identical to the Rectangle tool, except for the fact that it will retain the border radii settings from one instance to another as new rounded rectangles are created.

As is the case with the Rectangle tool, after a rounded rectangle has been created, we can further manipulate the small black diamonds at each corner to adjust the border radii.
Text tool

Using the Text tool, we are able to define text elements within an Edge project and modify certain visual properties of that element. We can choose to either click upon a location on the stage and begin typing or click and drag a textbox to whatever size is needed.

As well as by using these tools, any of the specific element properties can also be adjusted and changed through the Properties panel.

For More Information:
The Edge Application Interface

Background Color and Border Color
This simply provides quick access to both element background and border color selectors from the Edge application Toolbar.

Normally, this can also be modified through the Properties panel when an element has been selected.

The Stage
The Stage in an Edge project is the fundamental starting point of our element structure. Any additional elements created or imported will reside within and be animated upon this stage.

The stage itself is actually just another Symbol within Edge. The element which represents the Stage is the only HTML element, which can be seen when viewing the source code of the .html file produced by Edge.

For More Information:
Chapter 2

<!DOCTYPE html>
<html>
<head>
<title>Untitled</title>
<!--Adobe Edge Runtime-->
<script type="text/javascript" charset="utf-8"
src="BasicEdgeProject_edgePreload.js"></script>
<!--Adobe Edge Runtime End-->
</head>
<body style="margin:0;padding:0;">
<div id="stage" class=" EDGE-3551296988">
</div>
</body>
</html>

Downloading the example code
You can download the example code files for all Packt books you have purchased from your account at http://www.packtpub.com. If you purchased this book elsewhere, you can visit http://www.packtpub.com/support and register to have the files e-mailed directly to you.

The stage element for any particular Edge project will always have a unique class attribute, which is bound to jQuery functionality contained within the project's main JavaScript file. In the case of the previous code, the class value is EDGE-3551296988 and the JavaScript file in question is BasicEdgeProject_edge.js.

Have a look at the files within the sample BasicEdgeProject for the full project source.
Users coming to Edge from Flash Professional will undoubtedly notice some similarities, as Flash Professional also has the concept of a Stage. Though there are many differences between the two types, as in Edge, the stage is much more easily controlled through the motion engine, allowing us to resize or change the background color at will. In Flash Professional, the Stage is much more static; for instance, the background color cannot be animated in any such way as in Edge.

For More Information:
The Edge Application Interface

The Edge Timeline

The Timeline in Edge defines the various elements that are at play over time and exposes changes related to these elements in a visual way. The Edge Timeline is robust, yet simple to use. It inherits many of its attributes and behaviors from other applications such as After Effects and Flash Professional, yet it makes a good attempt to refine these concepts as well. The following is a screenshot of Edge Timeline:

Panels in Edge

For those familiar with other applications in the Adobe Creative Suite, the concept of panels will be quite familiar. As an example, in the following screenshot, we see panels as implemented in what is perhaps one of the most popular applications in the Creative Suite: Photoshop.

For More Information:
Panels are defined sets of functionality exposed through the application graphical user interface (GUI). Generally, the panels in Adobe Edge can be closed, combined, moved, resized, and collapsed as needed. Any panels that are not present in a particular workspace configuration can be opened through the Window menu commands.

### Elements panel
The Elements panel is a representation of all the HTML elements included as part of our Edge project. Every element is always nested within the stage and elements, which contain sub-elements, can be twirled down to expose those elements. We may also toggle visibility of particular elements by toggling the eye icon on and off, as well as the lock icon. When an element is locked, Edge will prevent us from modifying the properties of that particular element.

![Elements Panel](image)

To reorder elements, we can drag-and-drop individual elements within the Elements panel. This will effectively modify each element's z-index accordingly.

We can also toggle the visibility of any element by clicking the eye icon to the left of the element name. Clicking the small dot next to the eye will lock a particular element, disabling editing.

---

For More Information:
Library panel
The Library panel includes a listing of imported Assets such as bitmap and SVG images, a list of Symbols that have been created within Edge, and Font definitions, which can be used through text elements. The first two of these elements are added to the Library panel once they are included within an Edge project and can be added to the stage from this panel. The Font definitions are added through this interface and then referenced through text elements within the Properties panel.

By clicking upon the plus button attributed to either category, we can either add a new Asset through a file browse dialog or create a new Symbol from selected elements. Web Fonts can also be defined through the Library panel in this manner.

For More Information:
Properties panel
The Properties panel is one of the most important panels within Edge, as this is where all of the properties of an element can be modified. The properties available to us will depend upon the element that has been selected. For instance, the Stage will have very few properties in comparison to a rectangle or text element. Following is the screenshot of the Properties panel:

Many of the Adobe Creative Suite applications include the concept of a properties panel. Applications such as Flash Professional, which have been inherited from Macromedia, normally feature this panel quite prominently among the various application panels.

For More Information:
The Edge Application Interface

Actions panel

The Actions panel in Edge allows us to insert small bits of JavaScript code into our compositions. This code comes in the form of Triggers, Events, and Actions. The basic idea is that we are either able to write JavaScript in this panel, which conforms to the Edge Runtime API, or we can alternatively employ the buttons along the left side of the panel to insert preconfigured bits of code onto an element.

```
function(sym, c)
1 // play the timeline from the given position (ms or label)
2 sym.play(6000);
3 // Hide an Element.
4 // (sym.$("name") resolves an Edge element name to a DOM
5 // element that can be used with jQuery)
6 sym.$("Flower").hide();
```

Depending upon whether we are inserting code along the Timeline as a Trigger or upon an element or Symbol as an Event determines the options available for us in the options stack.
Summary
We should now be familiar with all of the menus, panels, and other interface elements available to us in within the Adobe Edge application window. While we have touched upon some basic functionality in this chapter, the following chapters will demonstrate a number of ways in which we can use Edge to create a variety of standards-based projects that leverage motion and interactivity to produce rich, engaging content for the web.

Next, we'll look specifically at the various tools available to us in Edge and how to import assets from other programs for use in our compositions.
Where to buy this book


Free shipping to the US, UK, Europe and selected Asian countries. For more information, please read our shipping policy.

Alternatively, you can buy the book from Amazon, BN.com, Computer Manuals and most internet book retailers.